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Introduction 
This document was created using the Accessible Digital Office Document (ADOD) 
Project.  The ADOD Project was developed by the Inclusive Design Research Centre, 
and OCAD University as part of an Enabling Change Partnership project. 

The purpose of this document is to ensure that the Town of New Tecumseth documents 
are created in a way that allows them to be viewed by assistive devices.  

This is a training manual and reference document for staff.  

Please consult the Accessible Digital Office Document Project for more information. 

Sighted people can look at a printed page and easily discern the difference between 
titles, subtitles, columns of text, headers, footers, and so on. Visual cues, such as 
location of the text on the page, bold text, and large font sizes help them determine the 
structure of a document so they can read and navigate it easily.  Unfortunately, assistive 
technologies such as screen readers can’t depend on these visual cues. They must 
instead rely on the underlying computer-based information to provide that same 
structure. 

General 
The following rules can be applied to most documents created in Microsoft Word, Excel 
and PowerPoint: 

• Design the source document with accessibility in mind; 
• Use program styles available in the application rather than character 

formatting for headings; 
• Add alternative text to all graphics and images; 
• Create the PDF in a manner that generates tags; 
• Check the accessibility of a document after conversion using the Full 

Check feature in Adobe Acrobat Professional (available in both version 9 
or 10) 

• When adding accessibility features to a document they should always be 
added to the source document first (if possible) as it is often faster and 
easier. 

Style guidelines 
When formatting text, especially when the text is likely to printed, try to: 

• Use font sizes between 12 and 14 points for body text. 
• Use fonts of normal weight, rather than bold or light weight fonts.  If you do 

choose to use bold fonts for emphasis, use them sparingly.  
• Use standard fonts with clear spacing and easily recognized upper and 

lower case characters, e.g., Arial, Verdana. 
• Avoid large amounts of text set all in caps, italic or underlined. 

http://adod.idrc.ocad.ca/
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• Do not condense or stretch lines of text. It is recommended that text align 
to the left margin as it is easy to find the start of the next line and keeps 
the spaces even between words. 

• Use bullets and numbering to create lists and outlines 
• Choose a sharp colour contrast for all elements of a document 
• Avoid using text boxes 
• Set font colour to “automatic” or “black” 
• Use heading styles to control line spacing rather than the enter key 
• Place white space between text and graphics/images 
• Do not use watermarks or backgrounds 

 
By taking the time to design your content in a consistent way, it will be easier to access, 
navigate and interpret for all users: 

• Whenever possible, write clearly with short sentences. 
• Introduce acronyms and spell out abbreviations. 
• Avoid making the document too “busy” by using lots of whitespace and by 

avoiding too many different colors, fonts and images. 
• If content is repeated on multiple pages within a document or within a set 

of documents (e.g., headings, footings, etc.), it should occur consistently 
each time it is repeated.   

• Ensure text for links is descriptive (e.g. don’t use “click here”)  
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Microsoft Word 
Styles 
You should attempt to make use of the named styles that are included in Microsoft 
Office. Styles make a document easier to navigate for users of assistive technology. 

Word includes several built-in styles that are always available, some of which are key to 
using different Word features. For example, Normal style is the default paragraph style 
for all text in your Word document.  

Normal is the style on which most other paragraph styles are based. That means if you 
change Normal style (such as changing the font style or size), many other styles will 
automatically change to match. As you can imagine, this kind of link between styles can 
be incredibly useful. It can also be incredibly frustrating if used incorrectly. 

Perhaps the most dynamic of the built-in styles are the paragraph styles Heading 1 
through Heading 9.  

 

Headings 
Documents that are longer than a few paragraphs require structuring to make them 
easier for readers to understand. The easiest way to do this is to use “Headings”.  
Headings create logical divisions between paragraphs. Headings are structural 
elements that provide a meaningful sequence to users of assistive technologies. 

Headings can be found under “Styles” in the Home Ribbon in Microsoft Word. 

Headings orient a user to a section or element. 

It is important that you use the numerical order of headings within your document.  You 
can only have one Heading1; followed by Heading2 etc.  You can have multiple 
Heading2 or Heading3… 

To modify a heading: 
1. Right click on the style 
2. Select Modify 
3. In the Modify Style dialog make the appropriate changes to the style 
4. Select OK 
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To apply a heading:  
1. Highlight the text you wish to apply the heading to. 
2. Select the appropriate heading from the Styles List. 

Alternate Text 
When using images or other graphical objects, such as charts and graphs, it is 
important to ensure that the information you intend to convey by the image is also 
conveyed to people who cannot see the image. This can be done by adding alternative 
text to each image. If an image is too complicated to concisely describe in the 
alternative text alone (flowcharts, etc.), you should provide a short text alternative and 
longer description as well. 

Tips for writing alternative text 

• Try to answer the question “what information is the image conveying?” 
• If the image does not convey any useful information, think about not using 

the image at all. 
• If the image contains meaningful text, ensure all the text is replicated 
• Alternative text should be short, usually a sentence or less. (rule of thumb 

40-60 characters) 
• If more description is required, provide a short description in the 

alternative text and more detail in the long description 
• Test by having others review the document with images replaced by the 

alternative text 

To add alternative text to images and graphical objects 

1. Right click the object 
2. Select Format Picture (or Size) 
3. Select the Alt Text tab in the Size dialog 
4. Fill in the Alterative Text 
5. Close 

 
Long Descriptions 
Long descriptions should be used when text alternatives are insufficient to answer the 
question “what information is the image conveying?”. 
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• In some situations, the information being conveyed will be how an image 
looks. In these cases, try to describe the image without making too many 
of your own assumptions. 

• One approach is to imagine you are describing the image to a person over 
the phone. 

• Ensure that you provide a concise alternative text to help readers decide if 
they are interested in the longer description. 

 
 

Avoid Using Images of Text 
Before you use an image to control the presentation of text (e.g. to ensure a certain font 
or colour combination), consider whether you can achieve the same result by styling 
“real text”. If this is not possible, as with logos containing stylized text, make sure to 
provide alternative text for the image following the techniques noted above. 

Tables 
When using tables, it is important to ensure that they are clear and appropriate 
structured.  This helps all users to better understand the information in the table and 
allows assistive technologies (e.g. screen readers) to provide context so that the 
information within the table can be conveyed in a meaningful way. 
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Tips for tables 

• Use “real tables” rather than text formatted to look like tables using the 
TAB key or space bar. These will not be recognized by assistive 
technology. 

• Keep tables simple by avoiding merged cells and dividing complex data 
sets into separate smaller tables, where possible. Whenever possible, use 
just one row of headings. 

• Create a text summary of the essential table contents. Any abbreviations 
should be explained in the summary. 

• Table captions or descriptions should answer the question “what is the 
table’s purpose and how is it organized?”. 

• Table cells should be marked as table headers when they serve as labels 
to help interpret the other cells in the table. 

• Table header cell labels should be concise and clear. 
• Ensure the table is not “floating” on the page. 

To add a table with headings 

1. Go to Insert tab 
2. Select the Tables icon 
3. Select the number of rows and columns you would like your table to have 
4. Select the table and a Table Tools menu item should appear 
5. Go to menu item Table Tools >Design 
6. In the Table Style Options section, select the Header Row Check box 

 

 

Lists 
When you create lists, it is important to format them as “real lists”. Otherwise, assistive 
technologies will interpret your list as a series of short separate paragraphs instead of a 
coherent list of related items. 

To create an ordered or unordered list 

1. Go to menu item: Home 
2. In the Paragraph section, select the Bullets icon for unordered list or 

select the Numbering icon for ordered lists 
3. To choose a different list format, select the arrow beside the icon 
4.  Select a format from the format Library that appears in the drop-down 

menu. 
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Page Breaks 
The Page Break feature is very important for assistive technology. Whenever you need 
to start a new page, select the Page Break feature instead of repeated hard returns 
(enter key). 

Page Breaks can be found under the Insert tab, or for other types of Breaks, click on 
the Page Layout tab and choose the down arrow beside Breaks. 

 

Table of Contents 
Creating an index or table of contents to outline office documents can provide a means 
of navigating the meaningful sequence of content. 

The best way to generate a table of contents is after applying the predefined heading 
styles, such as “Heading1” to the headings that you want to include in your table of 
contents. After you apply these styles, you can then create a table of contents. 

To insert a Table of Contents 

1. Place the cursor in your document where you want to create the table of 
contents. 

2. Go to menu item: References 
3. In the Table of Contents section, select Table of Contents 
4. Select the type of table you would like to insert: 

a. Automatic 
b. Manual or; 
c. “Insert” (this option gives you the ability to control the properties of 

the table) 
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To update the Table of Contents 

1. Select the table 
2. Go to menu item: References 
3. In the Table of Contents section, select the Update Table button 

 

 
 

Titles 
In case the document is ever converted into HTML, it should be given a descriptive and 
meaningful title.  

To change the title of the current document 

1. Go to menu item: File > Info > Properties 
2. Click Show Document Properties, in the banner that will appear select 

the Title text box 
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3. Enter the Title 
Note: The Title defined in the properties is different than the file name. 

  

Check Accessibility 
If you wish to check the accessibility of your document or template, there is an 
“Accessibility Checker” to review your document against a set of possible issues that 
users with disabilities may experience in your file. 

The “Accessibility Checker” classifies issues as 
• Error – content that makes a file very difficult or impossible for people with 

disabilities to understand 
• Warning – content that in most, but not all, cases makes a file difficult for 

people with disabilities to understand 
• Tip – content that people with disabilities can understand, but that might be 

better organized or presented in a way that would maximize their experience 

To use the “Accessibility Checker” 

1. Go to menu item: File  
2. Select Info in the left window pane 
3. Under Inspect Document click on Check Accessibility 
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4. The Accessibility Checker task pane will open on the right, showing the 
inspection results  

5. Click on the error that you would like to correct and look to the Additional 
Information at the bottom of the task pane, as highlighted below  

You may consider saving the file into HTML or PDF in order to perform an accessibility 
check in one of those formats, as described below. 
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Colour Contrast 
The visual presentation of text and images of text should have a contrast ration of at 
least 4.5:1. To help you determine the contrast, here are some examples on a white 
background: 

• Very good contrast (Foreground=black, Background=white, Ratio=21:1) 
• Acceptable contrast (Foreground=#767676, Background=white, 

Ratio=4.54:1) 
• Unacceptable contrast (Foreground=#AAAAAA, Background=white, 

Ratio=2.32:1) 
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Colour contrast differs from on screen to printed publications. These resources are for 
web colours of documents that would be viewed on the web only. 

In order to determine whether the colours in your document have enough contrast, you 
can consult an online contrast checker, such as: 

• Juicy Studio: Luminosity Color Contrast Ratio Analyzer  

Colour should not be used as the only visual means of conveying information, indicating 
an action, prompting a response or distinguishing a visual element.   

Write Clearly 
By taking the time to design your content in a consistent way, it will be easier to access, 
navigate and interpret for all users. 

• Whenever possible, write clearly with short sentences. 
• Introduce acronyms and spell out abbreviations. 
• Avoid making the document too “busy” by using lots of whitespace and by 

avoiding too many different colours, fonts and images. 

Document Language 
For assistive technologies (e.g., screen readers) to be able to present your document 
accurately, it is important to indicate the natural language of the document.  If a different 
natural language is used for a paragraph or selected text, this also needs to be clearly 
indicated. 

To change the default language 

1. Go to ribbon item: Review  
2. Select the Set Language  
3. Select the language from the Language drop-down list 
4. Select OK 

http://juicystudio.com/services/luminositycontrastratio.php
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Microsoft Powerpoint 
Use Built-In Layout and Styling Features 
PowerPoint 2010 does not offer “True Headings” or “Named Styles” as does Word 2010 
and 2013.  

Use Built-In Slide Layouts 
Instead of creating each slide in your presentation by starting from a blank slide, check 
whether there is a suitable built-in layout.  

Note: The built-in layouts can be more accessible to users of assistive technologies 
because technologies sometimes read the floating items on the slide in the order that 
they were placed on the slide. The built-in layouts have usually taken this into account 
(e.g., “Title” first followed by other items, left to right and from top to bottom). If you 
create slide layouts from scratch, it is sometimes difficult to keep track of the order 
elements were placed. 

To apply “true layout” to a slide 

1. Go to menu item: Home 
2. In the Slides section, select the Layout button 
3. Select the layout you would like to use from the drop-down menu
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Customize Using Master Slides 
If a layout must be customized, it is recommended that Master Slides be used. 

Every slide layout in a presentation is defined by its master slide. A master slide 
determines the formatting style for various elements of the slide layout. This includes 
font styles, character formatting, and the positioning of elements. Essentially, each 
master slide acts as a design template for the slide layout. 

If you edit any aspect of the slide layout in the master slide, the change will affect all 
slides that were created based on it. For this reason, it is good practice to edit the 
master slide and use the slide layouts before building individual slides. It is essential 
that you create and use master slides that meet the accessibility requirements outlined 
in this document. 

To create or customize a master slide 

1. Go to menu item: View 
2. In the Master Views section, select the Slide Master icon 
3. The current slide master with its associate layouts appears 

Note: If you have the Normal view open, the slide master is the larger slide 
image in the slide thumbnail pane. The associated layouts are positioned 
beneath the slide master. 

4. Customize the existing master slide and its associated layouts to suit your needs 
(e.g., apply a design, theme-based colors, fonts, effects, backgrounds) ensuring 
that your changes meet accessibility requirements 

5. Go to menu item: File > Save As > Other Formats 
6. In the File name box, type a file name 
7. In the Save as type list, select PowerPoint template 
8. Select Save 

On the Slide Master tab, in the Close section, select Close Master View
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Set a Logical Tab Order 
Many presentation applications create content composed almost exclusively of "floating" 
objects. This means that they avoid the transitions between in-line content and 
secondary "floating" objects (text boxes, images, etc.) that can cause accessibility 
issues in word processors. 

However, when you are working with "floating" objects, it is important to remember that 
the way objects are positioned in two dimensions on the screen may be completely 
different from how the objects will be read by a screen reader or navigated using a 
keyboard. The order that content is navigated sequentially is called the "Tab Order" 
because often the "Tab" key is used to navigate from one "floating" object to the next. 

Tips for setting a logical “tab order” for "floating" objects 

The tab order of floating objects is usually from the “lowest” object on the slide to the 
“highest”. Because objects automatically appear “on top” when they are inserted, the 
default tab order is from the first object inserted to the last. However, this will change if 
you use features such as “bring to front” and “send to back”. The slide’s main heading 
should be first in the tab order. 

Headings should be placed in the tab order immediately before the items (text, 
diagrams, etc.) for which they are acting as a heading. Labels should be in the reading 
order placed immediately before the objects that they label. For simple slide layouts, it 
may be possible to simply insert objects in a logical tab order. For more complex 
layouts, it may be easier to simply to create the slide as usual and then set the tab order 
(see below). 
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To set the tab order using the ‘Selection Pane’  

1. Go to Format 
2. In the Drawing section, select Arrange > Selection Pane 
3. In the Selection pane on the right of the screen, all the elements on the slide are 

listed in reverse chronological  
4. Elements can be re-ordered using the Re-order buttons located at the top of the 

Selection pane as highlighted 
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Use Slide Notes 
A useful aspect of presentation applications is the ability to add notes to slides, which 
can then be read by assistive technologies. You can use these slide notes to explain 
and expand on the contents of your slides in text format. Slide notes can be created as 
you build your presentation. 

To add notes to your slides 

1. Go to menu item: View 
2. In the Presentation Views section, select Outline View to ensure that the notes 

panel is in view 
Note: You can then select menu item  

3. The Notes Pane can be found at the bottom of the window, below the slide 
4. Type and format your notes within the Notes Pane below each slide 
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Microsoft Excel 
As you begin adding content, your spreadsheet will require structuring to bring meaning 
to the data, make it easier to navigate, and help assistive technologies read it 
accurately. One of the easiest ways to do this is to ensure that you properly format the 
cells. 

Named Styles 
You should make use of the named styles that are included with the office application 
(e.g., “Heading”, “Result”, etc.) before creating your own styles or using the character 
formatting tools directly. Named styles help your readers understand why something 
was formatted in each way, which is especially helpful when there are multiple reasons 
for the same formatting (e.g., it is common to use italics for emphasis, Latin terms and 
species names). 

Formatting header and result cells brings order to the spreadsheet and makes it easier 
for users to navigate effectively. For example, you can format header rows and columns 
using “Heading” styles to apply bolded, enlarged, and italicized text (among other 
characteristics). You may also want to format cells containing results of calculations to 
appear bold and underlined to help distinguish them from the rest of your data. 

To format a cell with default named styles 

1. Highlight the cells that you want to format 
Note: to apply a style to an entire row or column, select the row or column 
indicator and follow the next steps 

2. Go to menu item: Home 
3. In the Styles section, select the Cell Styles icon 
4. Select the desired formatting style from the drop-down menu 

Note: To modify a style, right-click* the desired formatting style from the 
drop-down menu and select Modify. Changes made to the style will affect 
all instances of the style within your workbook. 

 
Other Cell Characteristics 
Ensure your cells are formatted to properly represent your data, including number and 
text attributes. 

To format cell characteristics 

1. Highlight the cells that you want to format 
2. Go to menu item: Home 
3. In the relevant sections (e.g. Numbers, Font, etc.) make your adjustments 
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Note: When formatting your spreadsheet, it is best to avoid merging cells. At times, it 
may seem easier to present your data by merging cells, but this can make it more 
difficult for users of assistive technologies and people navigating your spreadsheet 
using the keyboard.  

Define Names 
Naming the different data ranges within your spreadsheet makes it easier to navigate 
through the document and find specific information. By associating a meaningful name 
to a data range, you will be enhancing the readability of your document. These named 
ranges can be referenced in multiple locations of your document and within calculations 
and equations. 

To define a name 

1. Highlight the cells you would like to name 
2. Go to menu item: Formulas 
3. In the Defined Names section, select the Define Name button 
4. In the Name text box, enter the name for the data range 
5. In the Scope drop-down list, select scope within which the name can be 

referenced 
6. Select OK 

 
 

Create Accessible Charts 
Spreadsheet applications support various types of charts, which can be used to display 
your spreadsheet data in meaningful ways for your audience. It is important to ensure 
that your chart is as accessible as possible to all members of your audience. All basic 
accessibility considerations that are applied to the rest of your document must also be 
applied to your charts and the elements within your charts. For example, use shape and 
color, rather than color alone, to convey information. As well, some further steps should 
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be taken to ensure that the contents are your chart are appropriate labeled to give users 
reference points that will help to correctly interpret the information. 

To create a chart 

1. Select the data that you want to include in the chart 
2. Go to menu item: Insert 
3. In the Charts section, select the icon of the type of chart you would like to 

insert 
4. Select a Chart Type from the Chart Gallery in the drop-down menu 

To add titles and labels 

1. In the Chart Design menu section, go to menu item: Add Chart Element 
2. In the Data Labels, select More Data Label Options and add additional titles 

that you would like to define (e.g., Chart Title, Axis Titles, Data Labels) 
Note: It is a good idea to use as many of the titles and labels available in 
this section as possible. 

To apply a predefined Chart Layout 

1. In the Chart Design menu section 
2. In the Chart Layouts section, select a Quick Layout from the scrolling Chart 

Layouts gallery 

To change to a different predefined Chart Type 

1. In the Chart Design menu section 
2. In the Type section, select the Change Chart Type icon 
3. In the Change Chart Type dialog, select a chart type from the left pane 
4. Select a Chart Design from the right pane 
5. Select OK 

Other Chart Considerations 

• When creating line charts, use the formatting options to create different types 
of dotted lines to facilitate legibility for users who are color blind 

• Change the default colors to a color safe or gray-scale palette 
• Use the formatting options to change predefined colors, ensuring that they 

align with enough contrast requirements 
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Adobe 
In the Adobe Acrobat X Pro workflow, all PDF documents start with a source 
document created in an office document authoring application, such as Microsoft Word. 
Because source documents provide the starting point for the PDF documents, 
accessibility is critical. *Please note that the following Adobe instructions will only 
be applicable to those individuals who have Adobe Acrobat Pro on their 
computers.* 

See above techniques in order to create an accessible source document using 
Microsoft Office. 

For additional information, please contact Human Resources for discussion. 

Test for Accessibility Compliance 
The best way to test the accessibility of a document is to attempt to use the document 
with the tools that your readers will use. However, even if you don’t have a screen 
reader or other assistive device, you can use any of the following methods provided by 
Acrobat 10 Pro for checking the accessibility of a PDF. 

Tags 
Creating a tagged document directly from an authoring application is the best way to 
make PDFs accessible. However, if a PDF was created without tags, you can add them, 
using Add Tags to Document. Often Acrobat tags PDFs when you create them.  

Run Accessibility Checks 
For a more thorough review of the accessibility compliance of a document, use one of 
the accessibility check features available in Acrobat 10 Pro. The Accessibility Quick 
Check examines the PDF to see if it has searchable text, document structure tags, and 
appropriate security settings to make it accessible. To check for other types of 
accessibility problems, it is best to use the Accessibility Full Check. 

Logical Reading Order 
The order in which elements in a document are read by assistive software is determined 
by the reading order. Each section of page content appears as a separate highlighted 
region and is numbered according to its placement in the reading order. You can 
change the reading order of the highlighted regions without changing the actual 
appearance of the PDF. For example, by reordering highlighted regions on the page, 
you can make a figure and caption read at the specific point that they are referenced in 
the text without moving the elements on the page. 

Checking for Accessibility 
It is important to remember that creating tagged PDF documents is only one aspect of 
PDF accessibility. No matter which authoring application is used to add accessibility 
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features and create a PDF document, the following should also be performed in Adobe 
Professional to improve accessibility: 

• Tag the document (if it is not already completed) 
• Perform an accessibility Full Check 
• Fix any reading order problems with the TouchUp Reading Order tool 
• Add additional accessibility features (set document language). 

 
The accessibility Full Check will provide a detailed report of the accessibility problems 
within the document. Each type of error detected by the checker may require 
adjustments to one of the following:  
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• Adjustments to the conversion settings: the conversion settings in PDF 
Maker must be set correctly prior to conversion to enhance accessibility. 

• Repairs to the Source File: Repairs made directly to the PDF file will be 
erased in subsequent PDF documents created from the same source file; 
therefore, it is recommended that all repairs/revisions are made to the 
source document and converted to PDF.  

• Repairs to the PDF File: a few repairs must be completed to the PDF file 
to improve accessibility.  This includes setting the document language, 
ensuring tab order is consistent with structure order and establishing 
headings for tables.  

 
Continue to check the document until there are no more accessibility issues to 
report.  

Document Structure Tags 
PDF tags are a mechanism for indicating the organizational structure of documents 
(e.g., headings, paragraphs, sections, tables, and other page elements) without 
changing the visual appearance of the PDF. These tags enable use with assistive 
devices, such as screen readers, indicate the document reading order and enable 
mobile devices to reflow and display the document on a small screen. 

An untagged document does not have structural information, and Acrobat must infer a 
structure. This situation often results in page items being read in the wrong order or not 
at all. For best results, tag the document when converting it to PDF from the authoring 
application. 
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To add tags automatically 

1. Go to menu item: Advanced > Accessibility > Add Tags To Document 
2. Note: This command removes any tags that were in the document before the 

command was run.  If any potential problems were encountered, an Add Tags 
Report appears in the navigation pane. 

The automatic tagging feature is usually enough for most standard layouts, but it 
sometimes cannot correctly interpret the structure and reading order of complex page 
elements (e.g. closely spaced columns, irregular text alignment, and tables without 
borders.). 

If testing reveals problems, it is necessary to edit and add tags manually using the 
following techniques. 

To add tags manually 

1. Using the TouchUp Reading Order tool, drag within the document pane to 
select a region of the page that contains one type of content (e.g. a text block) 

2. To add more page content to the current selection, Shift + drag 
3. To remove page content from the current selection, Ctrl + drag 
4. Select the appropriate button in the TouchUp Reading Order dialog to 

specify the tag type 

Reading Order 
The order in which elements in a document are read by assistive software is determined 
by the reading order. Each section of page content appears as a separate highlighted 
region and is numbered according to its placement in the reading order. You can 
change the reading order of the highlighted regions without changing the actual 
appearance of the PDF. For example, by reordering highlighted regions on the page, 
you can make a figure and caption read at the specific point that they are referenced in 
the text without moving the elements on the page. 

When to use the TouchUp Reading Order Tool 
The TouchUp Reading Order Tool provides a quick and easy way of fixing reading order 
and tagging problems in a PDF document.  The TouchUp Reading Order Tool can be 
used for the following: 

1. Check and repair reading order of content 
2. Tag interactive form fields 
3. Add alternative text to figures/images 
4. Add alternative descriptions to form fields 
5. Fix tagging of basic tables; and 
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6. Eliminate nonessential content from the tag tree (ornamental page borders) 
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The TouchUp Reading Order Tool provides the following options to users as part of the 
dialogue box: 

• Show page content order: Page elements are shown as highlighted numbered 
regions. The reading order of the document is associated with the sequence of 
the numbers on the highlighted regions. 

• Show Table Cells: The content of individual cells is shown in highlighted 
regions. This option allows the user to view any rows and/or columns that have 
been incorrectly merged/split. 

• Show Tables and Figures: Each table and figure in the document is outlined 
with a crossed-out box. This option allows the user to view the boundaries of a 
table and shows the alternative text for each figure. 

• Clear Page Structure: Tags from all visible pages will be removed. This option 
can be used if a page contains too many tagging problems and the user wishes 
to start again. 

• Show Order Panel: Selecting this option opens the Order Panel in the 
navigation pane. The order Panel can assist users with restricting and the 
reading order of the document. 

• Table Editor: By selecting this option, selected text will be automatically 
analyzed into cells with applicable tags. Please note that in order to use the 
Table Editor option, the table must be tagged as such. 
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• Edit Alternative Text: When a figure is highlighted and the user right-clicks on it, 
the edit alternative text option can be chosen. This option allows users to edit or 
add a text description to a figure. 

• Edit Form Field Text: When a user right-clicks on a form field, the edit form field 
text option can be chosen.  This option allows users to edit or add a text 
description to a form field.  

• Edit Table Summary: When user right-clicks on a highlighted table, the edit 
table summary option can be chosen.  This option allows users to edit or add a 
text description regarding the table properties. 

Scanned Documents 
Scanned documents are particularly difficult for assistive technology. They appear as an 
image. Assistive Technology does not read images unless there accompanied by “alt 
text”. Because a scanned document may be several pages long, it is impossible to 
provide adequate “alt text”. It is important to ensure that you are always starting with a 
source document that is not scanned. 

If you have a scanned document and do not have access to the original source 
document, in order to make the document accessible, you must run it through Optical 
Character Recognition (“OCR”).This feature can be found in all Professional versions of 
Adobe. 

OCR will force Adobe to recognize the text. Once OCR has been run, you can manually 
add tags and alter the reading order. 

On occasion, the OCR tool cannot recognize all the text within a document. The tool, 
however, gives the user the ability to examine, confirm and correct questionable text in 
the document. 

Searchable Text 
Searchable text is an essential characteristic of an accessible PDF document. Assistive 
technology devices, such as screen readers, require documents to have searchable text 
to allow text to be converted into speech.  A document that has been scanned creates a 
graphic representation of the content which prevents the text from being searchable; 
therefore, making scanned images inherently inaccessible. Users of screen readers 
cannot select or edit the text of a PDF document that is essentially a scanned image. 
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